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CHAPTER 1.  GETTING STARTED 
 
Introduction 
 
Thank you for purchasing the UMAX Astra 4000U scanner.  This high-resolution 1200 x 2400 dpi scanner 
is perfect for your many scanning needs. 
 
The Astra 4000U scanner is equipped with a USB connector that allows you to make a fast and easy 
connection to the USB port on your PC, or USB-equipped Macintosh computer (such as the iMac or blue 
and white G3). 
 
In addition to being easy to connect, this scanner is also easy to use.  Simply follow the instructions in this 
guide and you’ll be scanning in no time.  With the powerful software included with your scanner, you can 
create an archive of scanned images, e-mail or fax images to friends or clients, or create your own Web site 
gallery.  Get ready to unleash your creativity with the UMAX Astra 4000U scanner. 
 
Unpacking the Scanner 
 
Your scanner package includes the cables and software you need to get the scanner up and running.  The 
scanner package should contain all of the items listed below.  If you do not find all of the listed items, 
contact the retailer from whom you purchased the scanner, or contact UMAX.  For information on 
contacting UMAX directly, refer to Chapter 6.  How to Find Help. 
 
Package Contents 
 
• UMAX Astra 4000U Flatbed scanner 
• USB Interface Cable 
• Quick Start Guide and Owner’s Manual 
• Power cable 
• Adobe® PhotoShop LE CD-ROM 
• UMAX Scanner CD-ROM.  This CD-ROM contains software for UMAX VistaScan, VistaAccess, 

VistaShuttle (PC), Caere® OmniPage® LE OCR, NewSoft® Presto! PageManager, Newsoft® 
Presto! PhotoAlbumтм LE, NewSoft® Presto! PageTypeтм (PC), UMAX Copy Utility (PC), Presto! 
ImageFolio LE (PC) 

 
Getting to Know Your Scanner 
 
To gain a complete understanding of the information contained in this manual, it is important that you 
become familiar with your scanner.  The graphics below identify the key scanner components. 
 

 
             Astra 4000U Scanner Elements 
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            Astra 400U Back Panel 
 
System Requirements 
 
This section defines the minimum system requirements necessary to operate the Astra 4000U scanner.  
Please refer to the section below that applies to your scanner and computer type. 
 
PC Requirements 
 
• An IBM-compatible PC with 80486, Pentium processor or higher 
• Microsoft® Windows 98, 95 OSR2, or higher 
• USB interface connector 
• 32 MB RAM 
• CD-ROM drive 
• 170 MB of available hard disk space 
 
Macintosh Requirements 
 
• iMac or USB-compatible Macintosh 
• Macintosh OS 8.0 or higher 
• USB interface connector 
• 32 MB RAM 
• CD-ROM drive 
• 170 MB of available hard disk space 
 
Installing the Software 
 
The PhotoShop LE installation procedure is different for Macintosh and PC computers.  Therefore, we have 
provided two separate sets of instructions.  Follow the set of instructions for your computer. 
 
Installing PhotoShop LE on Your PC 
 
NOTE:  PhotoShop LE is compatible with Windows 89, 95, and higher.  Use the following steps to install 
your scanning software rather than using the add/remove programs to install the software. 
 
1. Insert the Adobe PhotoShop LE CD-ROM into your CD-ROM drive. 
 
2. Click the Start button in the bottom left corner of the desktop. 
 
3. Choose Run from the Start menu.  The Run dialog box opens. 
 
4. Click the Browse button. 
 
5. Look in Photosle in the CD-ROM drive: example “Photosle (F:)” where “F” is your CD-ROM drove. 
 
6. Double-click the Photosle folder. 
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7. Click on Setup.exe to highlight it, and click the OK button.  The path to the Setup.exe file appears in 
the Open text box in the Run dialog box. 

 
8. Click OK to launch the Setup file.  Follow the screen prompts. 
 
9. When the User Information dialog box appears, enter your personal information and the software serial 

number that appears in the upper right corner of the PhotoShop registration card.  You can find the 
registration card in the CD-ROM case. 

 
10. Continue with the installation process by following the remaining screen prompts. 
 
Installing PhotoShop LE on Your Macintosh 
 
1. Disable any virus-protection extensions and restart your computer. 
 
2. Insert the Adobe PhotoShop LE CD-ROM into your CD-ROM drive.  The PhotoShop LE CD-ROM 

content window appears. 
 
3. Double-click the Adobe PhotoShop LE icon.  The PhotoShop LE window appears. 
 
4. Double-click the Install PhotoShop LE icon.  Follow the screen prompts. 
 
5. When the User Information dialog box appears, enter your personal information and the software serial 

number that appears in the upper right corner of the PhotoShop registration card.  You can find the 
registration card in the CD-ROM case. 

 
6. Click the Install Now… button. 
 
7. Continue with the installation process by following the remaining screen prompts. 
 
Install Vistascan and Bundle Software (Presto! PageManager, Presto! PhotoAlbum, Presto! 
PageType, Presto! ImageFolio, OmniPage LE, and Online Manuals) 
 
1. Insert the UMAX Scanner CD into your computer’s CD-ROM drive after you have finished installing 

the software on the PhotoDeluxe CD. 
 
FOR PC USERS:  If your computer does not automatically begin installing the programs contained on 
this disk after inserting it into the CD-ROM, click on the Start bar, select Run…  A dialog box 
appears.  Type “d:/setup” in the dialog box.  If your CD-ROM is designated with another letter, 
substitute the appropriate letter for the drive. 
 
FOR MACINTOSH USERS:  When the UMAX VistaScan window opens on your desktop, double-
click on the UMAX CD Installer icon to begin the software installation. 

 
2. Follow the onscreen instructions to complete the installation of Presto! PageManager, UMAX 

VistaScan, OmniPage LE, and the online User’s Guide. 
 
3. Restart your computer as suggested by the onscreen instructions to complete the installation. 
 
Installing the Hardware 
 
After you have removed the scanner from the box and verified that all of the package contents have been 
included, please check to make sure that your computer is compatible with the scanner’s connectors. 
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About Scanner Connectors 
 
USB Connectors 
 
Many newer computers, both PC and Macintosh, rely on USB technology as the primary method of 
communication with computer peripherals.  With this new USB “plug-and-play” technology your computer 
automatically configures itself to work with USB peripherals. 
 
If your computer has a USB port, you must make sure that this port is enabled in the system BIOS.  Please 
refer to the troubleshooting section to learn more about enabling the USB port. 
 
Checking Your Computer’s Connectors 
 
To use your scanner you need to understand what type of connectors you have on your computer.  To 
determine the connector type, look at the pack panel of your computer: 
 
• A USB port is a small slot ½” long and ¼” wide. 
 

 
 

NOTE:  If your computer has a USB port, check to make sure that your computer’s operating system 
supports USB.  The following factory-installed operating systems support USB:  Microsoft Window 95 
OSR2, 98 or higher, and Mac OS 8.0. 
 
Setting Up – General Information 
 
• Find a suitable location near your computer to place the scanner. 
 

CAUTION:  Make sure the surface is flat.  Operating your scanner on an uneven surface can damage 
the internal components. 

 
Connecting the Hardware Interface Cables 
 
If your computer has a USB port, follow the instructions in the Connecting the USB Cable section to 
connect the scanner to your computer. 
 
Connecting the USB Cable 
 
The instructions for connecting the hardware interface cable are different for PC and Macintosh users.  
Refer to the section below that applies to your computer type. 
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1. Locate the USB cable that is provided.  First, plug one end of this cable firmly into the USB port on 

the back of the scanner. 
 
2. Second, plug the other end of this cable into the port located on the back panel of the computer. 
 
Macintosh Connection 
 
1. Locate the USB cable that is provided.  Plug one end of it firmly into one of the USB ports.  IMac 

computer ports are located on the right side of the computer, or at either side of the keyboard.  The 
USB port on other Macintosh computers is located on the back panel of the computer, or on a USB 
interface card. 

 
2. Plug the other end of this cable into the port located on the back panel of the scanner. 
 

Connecting the Power Adapter 
 

1. Plug the scanner’s power cord into an electrical outlet. 
 
2. Insert the other end of this cable into the rear panel of the scanner.  The power indicator on the front 

panel of the scanner should now be illuminated. 
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CHAPTER 2.  YOUR FIRST SCAN 
 
Before you begin your first scan, you must install the scanner and the bundled software.  Refer to the Quick 
Start Guide for installation and scanner test instructions. 
 
You can perform a basic scan using any of the software applications bundled with this scanner.  For your 
first scan, we suggest using the PhotoDeluxe software. 
 
PCs and Macintosh have two different versions of the PhotoDeluxe software, so we have included two 
separate sets of instructions.  Please follow the proper set if instructions for your system. 
 
Scanning Your First Image With PhotoShop LE 
 
PC 
 
1. Open Adobe PhotoShop LE and select File, Import, Select Twain Source. 
 
2. Select VistaScan as your Twain source (need only step once). 
 
3. Select File, Import, Twain_32 to launch VistaScan driver. 
 
Macintosh 
 
1. Open Adobe PhotoShop LE. 
 
2. Choose Import from the File menu. 
 
3. Click UMAX VistaScan from the dropdown menu.  The VistaScan window opens. 
 
4. Lift the document cover and place the item face-down so the top center of the document aligns with the 

arrow (   ) at the back edge of the object glass. 
 

 
 

5. Click the Preview button on the right side of the VistaScan Beginner window.  The scanner begins a 
low-resolution scan of the item. 

 
6. When the preview scan is complete the preview image is displayed in the Preview window (on the left 

side of the VistaScan window). 
 

You can change the view of the Preview image using the “Zoom Tool,” or select a scanning region 
using the “Frame Selection Tool”.  To find out more about how to use these tools, click on the user tips 
text that appears when your cursor pauses over the tool. 
 
NOTE:  You must have a browser installed in order to view the VistaScan online help. 
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7. In the Click to Scan section of the VistaScan Beginner window, click the icon that corresponds to the 
type of image you are scanning. 

 
For example, to scan a color photograph, choose “Color Photo”.  To scan text or a black and white 
drawing, choose “Text/Lineart”.  The image is scanned and you return to the PhotoShop LE window. 
 

8. NOTE:  Choosing an icon in the “Click to Scan” area does tow things:  it activates the scanner, and 
automatically sets the scanner settings to ensure the best scanning results. 

 
9. VistaScan closes and the scanned image appears in PhotoShop. 
 
10. Modify the image using the PhotoShop tools. 
 
11. Choose Save As from the File menu to save the scanned image. 
 
Turning the Scanner Lamp On and Off 
 
The scanner lamp remains on whenever the scanner has power, unless you turn it off using the VistaAccess 
Power Saving utility.  Turning off the scanner lamp when you are not scanning prolongs the life of the 
lamp. 
 
The Power Saving window is located in VistaAccess.  See “Using VistaAccess” for information on 
accessing VistaAccess.  Inside VistaAccess you will find Lamp On/Off Control.  Click on Lamp On/Off 
Control.  You will find a button to shut the lamp off or turn it on.  Also you can set a timer to 
automatically power off the lamp after at selected period of time. 
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CHAPTER 3.  SCANNING BASICS 
 
VistaScan is the primary program or driver you use to scan with your Astra 4000U scanner.  It is a 
TWAIN-compliant program, which means that it can be run from other programs that support scanning, 
like PhotoDeluxe, OmniPage, and others.  It is also a stand-alone program, which allows you to scan 
images for a variety of uses, even without launching another program first. 
 
Setting VistaScan Preferences 
 
Preferences control scanner settings that you generally do not modify every time you use the scanner.  The 
Preference settings are used as the default settings for several of the scan settings. 
 
To access the VistaScan Preferences, click the Preferences icon in the upper right corner of the VistaScan 
window. 
 
The Preferences cover three areas: 
 
• General 
• Scan Destination 
• Scanner Information 
 
A tab at the top of the Preferences window indicates each VistaScan preference group.  To view the 
Preference settings for an area, click on the associated tab. 
 
General 
 
The General tab contains preference settings that control color matching and color correction, and whether 
to display the ruler and tips. 
 

  
 

Color Matching/Correction 
 
Color Matching allows you to fine-tune the colors of scanned images so that they emulate the colors of 
your original source documents as closely as possible.  This is accomplished using MagicMatch. 
 
When you click on the MagicMatch checkbox (so a checkmark appears) the Profile List displays.  A profile 
list of applicable calibration profiles, which MagicMatch uses to render a final output image.  If a printer or 
calibration profile is not chosen, MagicMatch will calibrate the image to optimize its display on a monitor. 
 
MagicMatch only functions when you are scanning in color mode.  When you are using MagicMatch, it 
automatically disables the Level/Curve and Color Adjustment/Balance settings in the VistaScan Advanced 
window. 
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Show Ruler 
 
The Show Ruler command displays or hides the rulers that border the top and left sides of the Preview 
window.  These rulers correspond to the rulers on your scanner’s object glass.  Clicking on the Show Ruler 
checkbox turns off (removes the checkmark) and hides the ruler.  Clicking on the checkbox again turns the 
feature on (displays a checkmark) and shows the ruler. 
 
Tips Help 
 
The Tips Help option determines whether tips are displayed when you pause with your cursor over a 
VistaScan option.  Click on the Tips Help box to enable tips (displays a checkmark).  When a checkmark 
appears, clicking the checkbox disables the tips and removes the checkmark. 
 
Scan Destination 
 
The options in this Preferences tab specify how scanned images are stored, printed, faxed, transferred to 
another application, or transmitted via e-mail. 
 

    
 
File 
 
To set the location of your stored images: 
 
1. Click on the File icon.  The file preferences appear to the right of the Scan To icon set. 
 

 
 
2. In the File Directory box, enter the directory to where you want to store the scanned image file.  If you 

are not sure of the directory path, click the Browse button to locate the desired directory. 
 
3. Enter the file name under which you want to store the scanned image files (such as TMP) in the File 

Name text box. 
 
4. Select the file format in which you want to save scanned images from the File Format drop down list. 
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Printer 
 
To specify which printer to use when printing scanned images: 
 
1. Click on the Printer icon.  The printer currently selected as the default appears to the right of the Scan 

To icon set. 

 
2. If you want to change any of the printer settings, click on the Properties button.  The standard Print 

Setup dialog box opens.  Make any changes you want, and then click OK to return to the Preference 
settings. 

 
E-mail 
 
To specify which e-mail application to use when you e-mail scanned images: 
 
1. Click on the E-mail icon.  The e-mail preferences appear to the right of the Scan To icon set. 

 
2. Click on the button next to the e-mail software you are using (Microsoft Exchange or Lotus cc:Mail). 
 
3. Select the image format you want to use when you attach scanned images to your email application 

from the Image Format drop down list. 
 
Note:  For other e-mail applications, first “scan to file” then attach the saved file to your email using your 
email application. 
 
Fax 
 
1. Click on the Fax icon.  The fax driver (or printer driver if a fax driver is not selected) currently 

selected as the default appears to the right of the Scan To icon set. 
 

 
 

2. To change the settings, click on the Properties button.  The standard Print Setup dialog box opens.  
Make any changes you want, and then click OK to return to the Preference settings. 

 
Application 
 
1. Click on the Application icon.  The application preferences appear to the right of the Scan To icon set. 
 
2. Enter the application name to which you want to send the scanned image files (such as Presto! 

PageManager) in the Application Name text box. 
 
3. Enter the file name of the application executable in the File Name text box.  If you are not sure of the 

directory path, click the Browse button to locate the correct path. 
 
4. Select the image format in which you want to save scanned images from the Image Format drop 

down list. 
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Scanner Information 
 
The Scanner Information tab displays information about your scanner.  The information includes: 
 
• Scanner Manufacturer 
• Scanner Model 
• Firmware Version 
• VistaScan Version 
• Maximum Scan Width and Length 
• Maximum Resolution 
 
VistaScan Beginner Window Features 
 
The VistaScan Beginner window appears when you launch VistaScan.  The features of the VistaScan 
Beginner window let you scan a wide variety of documents, photos, and graphics.  Just click a button. 
 

   
 
Scanning an item via the Beginner window consists of just a few steps: 
 
1. Perform a preview scan of the item to be scanned by clicking the Preview button.  The item is quickly 

scanned at low-resolution, and is displayed in the Preview window (on the left side of the VistaScan 
Beginner window). 

 
2. Select what you want to do with the image after it is scanned using the Scan To icons. 
 
3. Specify what kind of image you are going to scan, and start the final scan process using the Click To 

Scan icons. 
 
Performing the Preview Scan 
 
The Preview feature lets you scan an item at low-resolution so you can define the specific area to be 
scanned when you scan at higher resolution. 
 
To preview the item you are going to scan: 
 
1. Place the item you want to scan face-down on the object glass, under the inverted triangle that appears 

in the center of the rear ruler. 
 
2. Click the Preview button on the right side of the Beginner window. 
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The image is quickly scanned and displayed in the Preview window. 
 
There are three Preview tools in the VistaScan Beginner window. 
 

    
 
Zoom tool – Lets you enlarge or reduce the view of the image in the Preview window.  To use the Zoom 
tool: 
 
Once the preview image appears in the Preview window, click on the Magnifying Glass icon. 
 
Move your cursor into the Preview window and click.  The image enlarges.  To reduce the view size, press 
the sift key (the command key on the Macintosh) and click in the Preview window. 
 
Frame tool – Lets you select the portion of the image displayed in the Preview window you want scanned 
in the final scan step. 
 
You can size the selection frame by clicking on the Frame tool and placing your cursor over one of the 
four edges of the frame (which changes the cursor shape to a two-headed arrow), drag the frame inward to 
reduce the size, or outward to increase the size. 
 
You can also move a selected frame by positioning the cursor inside the frame (which changes the cursor 
shape to a four-direction arrow), and dragging the frame to another location in the Preview window. 
 
Move tool – Lets you move an image in the Preview window so you can see portions that are not visible 
because the image is zoomed too large to display completely.  Click on the Move tool.  Put the cursor 
inside the preview window (which changes the cursor shape to a hand).  Scroll the image view by clicking 
and dragging the cursor. 
 
Selecting the Scan to Device or Application 
 
To specify the device or application to which you want to send the scanned item, click on the icon that 
represents this device or application. 
 
The icons include: 
 
 File – stores the scanned image in a file using the file name specified in the VistaScan Preferences. 
 

Print – prints the scanned item on the default printer. 
 
Fax – faxes the scanned item using your fax driver. 

 
Application – sends the scanned item to the applications specified in the VistaScan Preferences. 
 
E-mail – sends the scanned item as a graphic file to your Microsoft Exchange or Lotus cc:Mail e-
mail application.  (NOTE:  Other e-mail applications are not supported.) 
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Defining the Type of Image to Scan 
 
The Beginner window provides pre-defined scanning options so you can quickly and easily scan any of the 
following items: 
 
• Color Photos – use this setting when you want to scan color or black and white photos 
• Printed Matter – use this setting when you want to scan something that has been printed like a 

brochure, magazine, etc. 
• Text/Lineart documents – use this setting when you want to scan the text contained in a document, or 

when you want to scan simple lineart graphics 
• Web Images – use this setting when you want to scan graphics and then use them on the web 
 
To specify the type of image you are going to scan, click on the icon that represents the type of item you 
want to scan.  Clicking on any of these icons automatically starts the final scan process using the pre-
defined scan settings.  The scanned image is saved or sent to the device or application you specified by 
clicking on the Scan To icon. 
 
VistaScan Advanced Features 
 
The VistaScan Advanced window gives you the ability to adjust the scan setting individually so you can 
customize the settings for the type of document you are going to scan.  If you are a novice computer user, 
you may want to use the VistaScan Beginner window until you are more familiar with VistaScan and the 
scanning process.  The Beginner window options are preset to provide a quick and easy way to scan 
images. 
 
If you are an experienced computer user with some scanning experience, you can use the features contained 
in the Advanced window to optimize the scan process for the specific item you are going to scan. 
 
The Advanced window contains the following tools and features you can use to scan documents: 
 
• Original Document Source Settings 
• Image Mode Settings 
• Resolution Settings 
• Descreen Settings 
• Filter Settings 
• Scaling Options 
• Auto Adjustment Setting 
• Scan Control Unit 
• Multiple Scan Mode Settings 
• Color Adjustment Feature Panel 
 
Changing the Original Document Source 
 
The Original Document Source setting identifies the item you want to scan. 
 

     
 
You can choose from the following settings: 
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Flatbed Reflective:  Scans paper originals (non-transparencies) e.g., photographs, documents, and 
brochures. 
 
Three other setting options appear onscreen that are available with this scanner:  UTA Transmissive, UTA 
Negative, Automatic Document Feeder. 
 
Changing the Image Mode 
 
VistaScan can scan a wide variety of image types. 
 

     
 
True Color, RGB:  Scans a full color photo or document.  The RGB indicates the colors of Red, Green, 
and Blue.  This setting creates larger files than the B/W Photo setting. 
 
True Color, CMYK:  Converts RGB (video) color data into CMYK (printed) color data using a special 
color transformation process.  When scanning is completed the CMYK image is ready for printing on a 
CMYK color printer. 
 
NOTE:  Most home printers work better using RGB than CMYK. 
 
256 Colors:  Scans color images using 256 colors.  The 256 color images take up less memory and hard 
disk space than the True Color RGB option. 
 
Web Photo:  Scans an image at the appropriate resolution for display on the monitor. 
 
B/W Photo:  Scans black-and-white photos using 256 shades of gray (ranging from white to black) so you 
get smooth shade transitions in your scanned image. 
 
B/W Document:  Scans text documents, black-and-white line art, and other black-and-white documents.  
This selection creates the smallest files. 
 
FAX:  Scans at the appropriate resolution for faxing. 
 
OCR:  Scans at the appropriate settings for optimal OCR recognition. 
 
True Color 36-bit RGB:  Scans a full-color photo or document using 36-bits of information to define each 
pixel.  The RGB indicates the colors of Red, Green, and Blue.  This setting creates larger files than the True 
Color RGB setting. 
 
B/W Photo, 12-bit:  Scans a black-and-white photo using 12-bits of data to define each pixel.  This setting 
produces more gray shade accuracy than the B/W Photo option, but produces larger file sizes. 
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NOTE:  Not all graphic applications support 36-bit graphic files.  To determine whether the software you 
want to use is capable of working with 36-bit graphics, refer to your software documentation. 
 
Changing the Resolution Setting 
 
Scanning resolution is measured in dots per inch (DPI).  Resolution determines the amount of information 
the scanner will capture in a scanned image.  The higher the resolution, the finer the image detail, and the 
larger the file sizes. 

     
 
VistaScan lets you choose from the following resolution settings: 
 
• Higher – this option opens a drop down menu that contains higher resolution settings which include 

9600, 8400, 7200, 6000, 4800, 3600, 2400, 1800, and 1600 dpi selections. 
• 1200 
• 800 
• 600 
• 400 
• 300 
• 200 
• 150 
• 100 
• 75 
• Custom 
 
The table below gives you an idea of the file sizes you can expect based on the original image size and the 
resolution setting you specify.  These values are based on scanning images in 24-bit, True Color RGB 
mode.  Image sizes shown below are given in megabytes. 
 
Table 1. Resolution/File-Size Guidelines 

Resolution 
(dots per inch) Image Size 4x5 Image Size 5x7 

Image Size 
8.5x11 

72 0.30 0.53 1.39 
100 0.58 1.00 2.68 
200 2.29 4.01 10.70 
300 5.15 9.01 24.10 
400 9.16 16.00 42.80 
600 20.60 36.10 96.30 
800 36.60 64.10 171.20 
1200 82.40 144.20 385.20 
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NOTE:  Choosing the True Color RGB 36-bit setting captures more data than the 24-bit setting.  This 
means that the file sizes listed above will be larger if you scanned images using the True Color 36-bit RGB 
setting. 
 
Choosing the Best Resolution for Your Scanning Project 
 
To choose the best resolution for scanning, determine what you are going to do with the image once it is 
scanned.  Matching your scanning resolution to the image use will give you the best image for that purpose 
and will keep the file sizes to the minimum needed. 
 
Table 2. Recommended Resolutions 
Image Use Recommended Resolution 
Printing 300 - 600* 
Viewing on the Screen 72 
Viewing on the Web 72 
OCR, B/W 300 
Pre-Press 600 - 1200 
Enlarging 1200 
• Depending on the resolution of your printer. 
 
Using Custom Resolution Settings 
 
You can also specify custom resolution settings that you can use when you scan.  The maximum custom 
resolution setting you can define is 2400 dpi.  To define the custom resolution settings: 
 
1. Choose the Custom… option from the Resolution drop down menu.  The Custom Resolution window 

opens. 

 
 
2. Enter the desired resolution setting (between 50 and 2400 dpi) in the Custom resolution #1 box. 
 
3. Repeat step 2 to define the Custom resolution #2 and Custom resolution #3 settings. 
 
4. Click OK.  The settings you defined appear on the Resolution setting drop down menu, under the 

Custom heading. 
 
Changing the Descreen Feature 
 
The Descreen option helps eliminate the patterns that appear when you scan printed images found in 
magazines, brochures, catalogues, etc.  This is accomplished by changing the number of lines that appear in 
every inch (lines per inch) of the scanned image. 
 
The Descreen feature is unavailable when you have chosen the B/W Document, FAX, or OCR resolution 
settings. 
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To change the Descreen setting: 
 
1. Click the Descreen option to display the drop down menu. 
 

 
 
2. Choose one of the Descreen options: 
 

No Descreen – No Descreening. 
 
Magazine – Specifies 133 lines per inch.  This option smoothes the fine dot pattern found in glossy 
magazines. 
 
Newspaper – Specifies 85 lines per inch.  Smoothes the coarse grain pattern commonly found in 
newspaper images. 
 
Art Print – Specifies 175 lines per inch.  Smoothes the fine dot pattern found in high quality art print. 
 
Custom – Opens the Custom Descreen window, which allows you to specify a custom line screen 
value.  Refer to the Using Custom Descreen Settings section for information about how to set custom 
descreen values. 

 
Using Custom Descreen Settings 
 
You can also specify custom descreen settings that you can use when you want to change the lines per inch 
setting to eliminate patterns that are generated while scanning printed images.  You can enter custom 
settings that range from 35 to 400 lines per inch.  To define the custom descreen settings: 
 
1. Choose the Custom… option from the Descreen drop down menu.  The Custom Descreen window 

opens. 
 
2. Enter the desired lines per inch setting (between 35 and 400 lpi) in the Custom descreen lpi #1 text 

box. 
 
3. Repeat step 2 to define the Custom descreen #2 and Custom descreen #3 settings. 
 
4. Click OK.  The settings you defined appear on the Descreen setting drop down menu, under the 

Custom heading. 
 
Changing the Filter Setting 
 
Image filters are used to soften or sharpen edges and boundaries of an image. 
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VistaScan provides the following filter options: 
 
No Filter – Use this option when you do not want to sharpen or blur the image. 
 
Sharpen – Use this option to sharpen lines that may be fuzzy or not clean in the original image. 
 
Sharpen More – Use this option when you want to sharpen the image more than the standard Sharpen 
filter does. 
 
Blur – Use this option when you want to soften the edges of an image. 
 
Blur More – Use this option when you want to soften the edges more than the Blur filter does. 
 
Changing the Scale Factor 
 
Scaling lets you automatically enlarge or reduce an image from its original size (100%) as it is scanned.  
The scale factor affects the size of the scanned image and the printed scan output. 
 

     
 
You can scale the image using any of the scale factors listed below: 
 
• 200% 
• 150% 
• 100% 
• 50% 
• 25% 
• 10% 
• Custom 
 
You can specify a custom scale factor by choosing the Custom option from the Scaling drop down menu.  
See the Using Custom Scaling Settings section for more information about specifying a custom scale factor. 
 
Using Custom Scale Settings 
 
You can specify custom scaling settings to use when you scan.  To define the custom scaling settings: 
 
1. Choose the Custom… option from the Scaling drop down menu.  The Custom Scaling window opens. 
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2. Enter the desired scale factor in either the Width or Height text box.  When locked, width and height 

entries are identical.  The width and height fields are dynamic, updating one field automatically 
changes the other field.  If the scale output size is unlocked, you can se the width and height output 
dimensions individually. 

 
3. To change the unit of measure, click on the down arrow next to Height and/or Width text boxes to 

display the possible settings.  You can choose from Inch, Centimeter, Pixel, or Percent. 
 
4. Click OK. 
 
Using the Auto Adjustment Feature 
 
Auto Adjustment provides a simple way to adjust the light and dark values of a color or grayscale image 
you want to scan. 
 
To automatically adjust the light and dark values: 
 
1. Place the item you want to scan on the scanner’s object glass. 
 
2. Click the Preview button from the VistaScan Advanced window. 
 
3. Select an area that you want to adjust using the Frame tool 
 

You can edit the Preview image before scanning the final image using the “Zoom Tool” and the 
“Frame Selection Tool”.  To find out more about how to use these tools, click on the user tips text that 
appears when your cursor pauses over the tool. 
 
NOTE:  To use VistaScan online help you must have a browser installed on the system. 

 
4. Click the Auto Adjustment check box.  The selected area is adjusted and the preview image refreshes, 

displaying the results you can expect when you perform the final scan. 
 
Using the Scan Control Unit 
 
The Scan Control Unit contains the Preview and Scan buttons, and the Scan To options. 
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Selecting the Scan to Device or Application 
 
To specify the device or application to which you want to send the scanned item: 
 
1. Click the arrow above the Scan To text on the Scan Control Unit.  The Scan Control Unit panel slides 

back to display the Scan To icons. 
 

 
 
Click on the icon that represents the device or application to which you want to send the scanned item.  The 
icons include: 
 

File – stores the scanned image in a file using the file name specified in the VistaScan Preferences. 
 
Print – prints the scanned item on the default printer. 
 
Fax – faxes the scanned item using your fax driver. 
 
Application – sends the scanned item to the applications specified in the VistaScan Preferences. 
 
E-mail – sends the scanned item as a graphic file to your Microsoft Exchange or Lotus cc:Mail e-
mail application. 

 
Using the Multiple Scan Mode 
 
You can select multiple portions of the image you scanned in Preview mode using the Multiple Frame tool. 
 

      
 
The Multiple Frame tool allows you to create two or more selection frames in the Preview Window. 
 
To create more than one selection frame: 
 
1. After you have scanned an image in Preview scan mode, click on the Multiple Frame tool. 
 
2. Select the area you want contained in the first frame by clicking on the point at which you want to 

begin the frame, and then dragging the tool diagonally until the area of interest is contained in the 
marquis box. 

 
3. Click outside of a selected area to save the frame.  To create other frames, repeat steps 1 and 2 until 

you have created all the desired frames. 
 
4. After you create a frame, the Single Frame tool is automatically selected so you can resize or move the 

frame you just created. 
 
To select one of the frames you created, double-click on the desired frame.  The frame border of the active 
frame changes to a marquis style frame (dotted lines).  Once a frame is selected, double-click on a frame to 
display the Job Information window for that image, which contains the image information. 
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To remove a selected frame: 
 
 
1. Click on the Job List button.  Thumbnails of the selected frames appear in the job list window. 
 

 
 

2. Click on the thumbnail of the frame you want to remove.  A red box appears around the selected 
thumbnail.  The frame in the Preview window associated with the thumbnail changes to a dashed 
outline. 

 
3. Click on the X button, located in the bottom-left corner of the thumbnail, to remove the frame. 
 
Using the Color Adjustment Features 
 
The Color Adjustment features allow you to make adjustments to the colors and/or tones in an image.  The 
following lists the color adjustment settings you can modify: 
 
• Brightness, contrast, highlights, shadows, and gamma 
• Image tones 
• Color balance 
• Rotation/Invert 
 
Adjusting Image Brightness, Contrast, Highlights, and Shadows 
 
 
When you click on the Brightness/Contrast tab from the Color Adjustment panel a series of slide bars 
appear.  Adjust the associated tones by dragging the slider in one of the bars to the left or the right. 
 

 
 
Using the Brightness Bar 
 
This setting determines the overall intensity level (gray level) of an image.  Moving the slider on the scroll 
bar to the right increases the brightness.  Moving it to the left decreases the brightness.  The default setting 
is zero (0).  The Maximum brightness setting is 100, the minimum setting is –100. 
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Using the Contrast Bar 
 
This setting controls the difference between light and dark areas in an image.  Moving the slider on the 
scroll bar to the right increases the gray shades between light and dark areas.  Moving it to the left 
decreases gray shades between light and dark areas.  The default setting is zero (0).  The maximum contrast 
setting is 100, the minimum setting is –100. 
 
Highlight Bar 
 
This setting defines the lightest (whitest) tones in the scanned image.  If you broaden the range that 
includes the highlight points, the pixels within the newly specified range to be remapped allowing you to 
see more details in a color/gray image. 
 
Moving the slider on the scroll bar to the left increases the brightness.  Moving it to the right decreases the 
brightness.  The default setting is 255.  The maximum highlight setting is 255; the minimum setting is 1 
(white). 
 
Shadow Bar 
 
The Shadow bar defines the darkest tones in the scanned image.  Moving the slider on the scroll bar to the 
left increases the brightness in shadowed areas.  Moving it to the right decreases the brightness in 
shadowed areas.  The default setting is zero (0).  The maximum shadow setting is 254 (black); the 
minimum setting is zero (0). 
 
Gamma Bar 
 
The Gamma bar alters the mid-range gray tones in the scanned image.  All optical devices, such as 
monitors and scanners, have some variance in their light sensitivity characteristics.  To get a scanned image 
with good results, VistaScan provides gamma adjustment capabilities so you can compensate for this 
variance in your scanner. 
 
Moving the slider on the scroll bar to the right increases the brightness of the mid-range gray tones.  
Moving it to the left decreases the brightness of the mid-range gray tones.  The default setting is 1.2. 
 
Reset Button 
 
Click the Reset button to cancel the changes and return the value to the default setting. 
 
Adjusting the Image Tones 
 
The Curve command is another way to make precise adjustments in the highlight, midtones, or shadow 
levels in your images.  Using this feature corrects the gray/color values in an image.  You change the values 
by altering the shape of the curve that represents the brightness pixels. 
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Click Reset to cancel the changes and return the value to the default setting. 
 
Adjusting the Color Balance 
 
The Color Adjustment feature controls the hue and saturation of a particular color. 
 
When you click on the Color Balance tab from the Color Adjustments panel, a continuous color spectrum 
wheel appears. 

 
 

When you click in the wheel the image tones are shifted to the particular hue that is represented in that area. 
 
Click the Reset button to cancel the changes and return the value to default setting. 
 
Rotating/Inverting an Image 
 
You can rotate an image clockwise or counter clockwise, and you can flip images 180 degrees vertically or 
horizontally. 
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The following lists the possible rotate and flip selections: 
 
• Flip/Rotate Horizontally – flips the image horizontally and rotates it 90 degrees counter clockwise. 
• Flip Horizontal – flips the image horizontally. 
• Rotate 90 CCW – rotates the image 90 degrees counter clockwise. 
• Rotate 90 CW – rotates the image 90 degrees clockwise. 
• Normal – does not rotate or flip the image. 
• Flip Vertical – flips the image vertically. 
• Rotate 180 – rotates the image 180 degrees clockwise. 
• Inverts an image – changes all the dark tones in an image to light tones, and all of the light tones to 

dark tones.  This option can NOT be reversed using the Edit menu Undo command. 
 
Clicking on the image that shows the desired orientation rotates or flips the image.  Clicking the Reset 
button cancels the rotate or flip action and returns the image to the original orientation. 
 
Using VistaAccess – Direct Access 
 
VistaAccess is a utility that provides instant access to several VistaScan applications.  VistaAccess loads at 
startup, and can be found in the system tray.  When VistaAccess is open, it allows you to open any of the 
listed applications with a few clicks of your mouse. 
 
To use VistaAccess from the PC: 
 
a) Click on the Start bar.  Click on the Programs option.  When the Programs pop0-up menu appears, 

click the VistaScan option.  The VistaScan pop-up menu appears.  Click the VistaAccess option to 
display the scanner icon in the Windows Task bar (near the time display in the lower right corner of 
the window in the system tray). 

 
b) Click the scanner icon in the system tray using your right mouse button.  A pop-up menu appears 

which contains: 
 

• VistaScan 
• VistaShuttle 
• Copy Utility 
• Scanner Test 
• Push Button Configuration 
• Power Saving On/Off Control 
• Find/Refresh Scanner 
• Exit 
 

c) Click on one of the listed applications or utilities to launch the software. 
 
d) Click the Find/Refresh Scanner option to re-initialize the scanner.  Click the Help option to view 

VistaAccess online help.  Click the Exit option to remove the scanner icon from the Windows Task bar 
and close VistaAccess. 

 
To use VistaAccess from the Macintosh: 
 
1. Click on the control strip in the lower left corner of the Desktop.  A drop down menu appears which 

contains: 
 

• VistaScan 
• Power Saving On/Off Control 
• Find/Refresh Scanner 
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2. Click on one of the listed applications or utilities to launch the software. 
 
3. Click the Find/Refresh Scanner option to re-initialize the scanner.  Click the Help option to view 

VistaAccess online help.  Click the Exit option to remove the scanner icon from the Finder area and 
close VistaAccess. 

 
Using VistaShuttle 
 
VistaShuttle is a PC-based application that provides an easy way for you to create greeting cards, wallpaper 
for your computer desktop, a screen saver for your computer, e-cards (e-mail greeting cards), and more. 
 
NOTE:  VistaShuttle is not compatible with Macintosh. 
 
To use VistaShuttle to create an E-Card (electronic greeting card you send via e-mail): 
 
1. Click the scanner icon in the system tray (to the far right of the Windows task bar) using your right 

mouse button.  Select the VistaShuttle application from the VistaAccess menu.  The VistaShuttle Main 
window appears. 

 

 
 
2. Click on the E-Card icon.  The VistaScan Beginner window opens so you can scan an item to include 

in your electronic greeting card. 
 
3. Lift the scanner’s document cover and place your document face-down in the center of the scanner’s 

object glass. 
 
4. Click Preview to preview the scanned item.  You can edit the Preview image before scanning the final 

image using the “Zoom Tool” and the “Frame Selection Tool”.  To find out more about how to use 
these tools, click on the user tips text that appears when your cursor pauses over the tool. 

 
NOTE:  You must have a browser installed in order to view the VistaScan online help. 

 
5. Click the icon that most closely represents the item you are going to scan in the Click To Scan area of 

the VistaScan Beginner window. 
 

The item is scanned, and VistaScan automatically closes.  After a moment the VistaShuttle E-Card 
window appears with the scanned item in the default E-Card template. 

 
6. Click on the scanned item to display the image handles.  Drag one of the image handles outward to 

enlarge the image, or inward to reduce the image. 
 

You can customize the E-Card template frame that surrounds the scanned item, the stamp graphic, or 
the paper type by clicking the desired option from the buttons in the left column. 
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7. Click and drag any of the E-Card template elements to move them around, creating your own E-Card 

style. 
 
8. Choose the Add text command from the Text menu (or click on the Text button from the left-hand 

column).  The Text Setting window opens. 
 
9. Enter the E-Card greeting text in the text box. 
 
10. You can modify the font type, font size, font style (bold, italic, underlined), text alignment (left, right, 

centered), and text color by selecting an option from the drop-down lists or by clicking on the 
associated icon from the button bar at the top of the E-Card window. 

 
11. Click the Finish button to place the text on the card. 
 

 
 
12. Click the Close button in the upper right corner to close the Text Setting window.  You can move the 

text box around the E-Card until you find the right spot.  Click outside the text box to anchor the text to 
the chosen spot. 

 
13. Click the Mail button from the E-Card window.  The Send dialog box appears. 
 
14. Choose your e-mail application from those listed (only Microsoft Exchange and Lotus cc:Mail are 

supported), and click the Send button to open the application and attach your E-Card to the message. 
 
15. Send your e-mail message. 
 
Using the UMAX Copy Utility 
 
The UMAX Copy utility is a PC-based application that lets you scan and automatically print copies of an 
image. 
 
NOTE:  The UMAX Copy Utility is not Macintosh compatible. 
 
To use the copy utility: 
 
1. Click on the Start bar.  Click the Programs option.  When the Programs pop-up menu appears, click 

the VistaScan option.  The VistaScan pop-up menu appears.  Click the UMAX Copy Utility selection 
to open the program. 

 
2. The UMAX Copy Utility window appears. 
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3. Select your copy settings.  Click the Copy button to make the copies, then click Exit when you are 

finished. 
 
UMAX Copy Utility Features 
 
Brightness:  Lets you select the brightness levels to use when you print the copies of the scanned image.  If 
the image is too dark, click the up arrow to lighten the copy.  If the image is too light, click the down arrow 
to darken the copy. 
 
Original Image:  Lets you specify the type of image to be copied – Color, Gray, or B/W.  The Single 
Photo option automatically crops unnecessary white space around the image (no matter where the image is 
placed), and speeds up the scanning. 
 
Printout Quality:  Choose Normal for draft quality, or choose Best for high quality images. 
 
• B/W images – Selecting Best of Normal produces the same output. 
• Gray images – Selecting Best uses an enhanced filter to improve image quality but slows down the 

print speed. 
• Color images – Selecting Normal uses an enhanced filter to improve color quality; selecting Best uses 

the MagicMatch function to produce the best image quality. 
 
Printer Setup – Opens the Printer Setup dialog box. 
 
Reset – Returns any settings you have modified to the default settings. 
 
Exit – Returns you to the desktop window. 
 
Numeric Buttons – Lets you specify the number of copies by clicking on the desired number.  The number 
appears to the left. 
 
Scaling – Sets the printout size of your scanned image; the default is 100%. 
 
Copy/Stop – Copy your scanned image by clicking the Copy button.  When copying begins the button text 
changes to read Stop.  To stop printing copies, click the Stop button. 
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CHAPTER 4.  SCANNING PROJECTS 
 
The UMAX Astra 4000U scanner includes bundled software to help you with a variety of tasks.  This 
chapter shows you how to scan and print images, and even turn a page of text into an online text document 
that you can edit. 
 
Using VistaScan to Scan and Print Images 
 
To perform your first scan: 
 
1. Open the VistaScan software application. 
 
For PC Users: 

a. Click on the Start bar.  Click on the Programs option.  When the Programs pop-up menu 
appears, click the VistaScan option.  The VistaScan pop-up menu appears.  Click the 
VistaAccess option to display the scanner icon in the Windows Task bar (near the time display 
in the lower right corner of the window in the system tray). 

 
b. Click the scanner icon in the Task bar using your right mouse button.  A pop-up menu appears. 

 
c. Click on VistaScan to launch the software. 

 
Or you can also: 
 

a. Click on the Start bar in the bottom-left corner of the screen. 
b. Click Programs. 
c. Click VistaScan. 
d. Click VistaScan. 

 
For Macintosh Users: 
 

a. Click on the Scanner icon in the upper right corner of the Desktop (near the Finder).  A pop-up 
menu appears. 

 
b. Click on VistaScan to launch the software. 

 
Or you can also: 
 

a. Double-click the Hard Drive icon. 
b. Double-click the UMAX VistaScan folder. 
c. Double-click the UMAX VistaScan application icon to launch VistaScan. 

 
2. The VistaScan Beginner window appears.  Lift the scanner’s document cover and place your document 

face-down in the center of the scanner’s object glass. 
 
3. Click the Preview button to preview the scanned item.  You can edit the Preview image before 

scanning the final image using the “Zoom Tool” and the “Frame Selection Tool”.  To find out more 
about how to use these tools, click on the user tips text that appears when your cursor pauses over the 
tool. 

 
NOTE:  This feature is only available if you have a browser installed. 

 
4. Click the Printer icon in the “Scan to” control panel to indicate that you want to scan and print the 

image. 
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5. Click one of the four icons in the Click to Scan area of the VistaScan Beginner window.  Your 
selection identifies the type of image you are about to scan and tells VistaScan how to set the scanner 
options for the best results.  The image type selections include:  Color Photos, Text/Lineart, Web 
Images, and Printed Matter settings. 

 
Once you click on the desired image type, the scanner starts scanning the image using the appropriate 
settings. 
 
For Macintosh Users: 
After the scan is complete, a print window appears.  Verify that the destination settings are correct and 
then click the Print button. 

 
6. When the scan is complete, the image is printed on your printer. 
 
Using VistaScan to Scan a Photo to E-mail 
 
Scanning an image to e-mail is similar to the procedure described in the Using VistaScan to Scan and Print 
Images section earlier in this guide.  Follow steps 1 through 3 as listed in the Scan and Print instructions, 
then proceed with the following steps: 
 
1. Click on the E-mail icon to set the scanner settings to the best values for scanning an image to e-mail. 
 

NOTE:  You may need to adjust the destination preferences in the VistaScan Beginner window.  For 
information about setting preferences, refer to Setting the VistaScan Preferences section. 

 
2. Click on the Web Image icon in the Click to Scan area of the VistaScan Beginner window.  The 

scanner starts scanning the image using the appropriate settings for web images. 
 
3. After the image is scanned, a Microsoft Exchange or Lotus cc:Mail e-mail window appears with an 

icon representing the scanned image embedded in the message area of the window. 
 

NOTE:  For more information about using Microsoft Exchange or Lotus cc:Mail refer to the user 
documentation that came with the application. 

 
4. Fill out the rest of the standard e-mail information (address, subject, etc.) as you ordinarily would.  

Send the e-mail. 
 
Using Presto! PageManager to Scan a Form and Edit it with PageType 
 
NOTE:  Presto! PageType is not a Macintosh compatible application.  The following procedure is for PC 
users only. 
 
1. Click the Start bar in the bottom-left corner of the screen. 
 
2. Click Programs. 
 
3. Select Presto! PageManager. 
 
4. Select Presto! PageManager. 
 
5. The Presto! PageManager window appears. 
 
6. Choose Select Source from the File menu.  A window appears, choose VistaScan.  Select Acquire 

from the File menu.  The VistaScan Beginner window appears. 
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7. Lift the document cover and place the form you want to scan face-down in the center of the object 
glass of the scanner. 

 
8. Click the Preview button. 
 
9. Click the Text/Lineart icon in the Click to Scan area to begin the scan. 
 
10. When the scan is complete, click the Exit button at the bottom of the window.  The scanned image of 

your form appears in the PageManager Inbox window. 
 
11. Click and drag the scanned form down to the PageType application icon.  PageType opens and 

automatically displays the scanned form. 
 

 
 
12. Fill in the form text desired using the PageType tools. 
 
13. Save the image when you have finished editing the form by selecting Save As from the File menu and 

entering the relevant information. 
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Converting Scanned Text to Editable Text with OmniPage 
 
OmniPage lets you scan an image that contains text and convert it to editable text so you do not have to 
retype the text.  The process differs slightly for PC and Macintosh users.  Follow the appropriate 
instructions for the system that you are using. 
 
Opening OmniPage LE 
 
For PC Users: 
 
1. Click the Start bar in the bottom-left corner of the screen. 
 
2. Click Programs. 
 
3. Select the Caere Applications option. 
 
4. Select OmniPage LE to launch the application.  The OmniPage LE window appears. 
 

 
 
For Macintosh Users: 
 
1. Double-click the Hard Drive icon. 
 
2. Double-click OmniPage LE. 
 
3. Double-click the OmniPage LE icon.  An OmniPage toolbar appears.  (If this toolbar does not appear, 

click on the Window menu and select Show Toolbar.) 
 

 
 
4. Click Select Scanner from the Settings menu.  Select UMAX Astra Series then click OK. 
 
Converting Scanned Text with OmniPage LE 
 
1. Position the image you want to scan face-down on the scanner’s object glass. 

 34 

Download from Www.Somanuals.com. All Manuals Search And Download.



 
2. From the OmniPage LE window, click the Scanner icon and select Flatbed.  Click Done. 
 
For PC Users: 
 
1. Choose Acquire Image from the File menu.  Select Flatbed from the Paper Path field in the Load 

Scanner dialog box, then click Scan to scan the image.  When the scan is complete, the text appears in 
the OmniPage window. 

 
2. Click the OCR button to perform the character recognition. 
 
3. A small dialog box appears.  If you have additional pages to scan, click the Add Pages button and 

repeat steps 2 and 3. 
 
4. Click Stop Scanning when you have scanned all the desired pages, and enter the file name, file 

directory, and file type (the format in which you want to save the file). 
 
5. Click OK to save the recognized text. 
 
6. Open your word processor application.  Open the file that you just saved so you can review, edit, cut, 

or copy portions of the text. 
 
For Macintosh Users: 
 
1. Select Scanner from the Settings menu. 
 
2. Click Flatbed from the Select Scanner window. 
 
3. Click the Scan Image button to scan the image.  When the scan is complete, the text appears in the 

OmniPage window. 
 
4. Click the Perform OCR button. 
 
5. Click Save As to save the converted text. 
 
6. Choose Quit from the File menu to close OmniPage LE. 
 
7. Open your word processor application.  Open the file that you just saved to review, edit, cut, or copy 

portions of the text. 
 
Creating an Album with Presto! PhotoAlbum 
 
A variety of templates are included in Presto! PhotoAlbum that you can use for albums.  You can also save 
an album you create and use it later as a template for creating another album.  This process differs for PC 
and Macintosh users.  When a step is different for PC and Mac users, a note gives platform-specific 
instructions. 
 
Opening PhotoAlbum 
 
1. Open the Presto! PhotoAlbum program. 
 
For PC Users: 
 

a. Click the Start bar in the bottom-left corner of the screen. 
b. Click Programs. 
c. Select Presto! PhotoAlbum. 
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d. Select Presto! PhotoAlbum.  The PhotoAlbum window appears. 
 
For Macintosh Users: 
 

a. Double-click the Hard Drive icon. 
b. Double-click the Presto! PhotoAlbum application folder. 
c. Double-click the Presto! PhotoAlbum application icon to launch VistaScan.  The 

PhotoAlbum window appears. 
 

 
 
Creating a PhotoAlbum 
 
1. Click on the Create button, and then click on the Template button. 
 
2. Choose an album template category by selecting one of the category icons in the column on the left. 
 
3. Display the available template outlines by clicking on the template thumbnail.  Browse through the 

template thumbnails using the scroll bar. 
 

NOTE:  Clicking on the thumbnail displays a description of the layout.  The description includes 
information when the layout was originally created and how many pages are contained in the layout. 

 
4. When you have chosen a template, click OK.  After a moment the template appears. 
 
5. Click on the Command icon in the upper-left corner of the floating Photo Browser window.  If this 

window is not displayed, click on the Photo Browser button, located on the left side of the row of three 
icons on the bottom on the screen. 

 
6. Choose Select TWAIN Source from the drop-down menu.  Choose VistaScan, then click the Select 

button. 
 
7. Click on the Photo Browser window Command icon again, and then click Acquire to activate the 

scanner and launch VistaScan.  The VistaScan Beginner window opens. 
 
8. Lift the document cover and place the image you want to scan face-down in the center of the object 

glass of the scanner. 
 
9. Click the Preview button to perform a preliminary low-resolution scan of the photo you want to 

include in the album. 
 
10. Specify the area to be scanned in the final scan using the VistaScan Frame Tool. 
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11. Click on the Color Photos icon in the Click to Scan area of the VistaScan Beginner window.  The 

scanner performs the final, high-resolution scan. 
 
For PC Users: 
 

After the scan is complete, click the Exit button. 
 
12. A thumbnail of the image you just scanned appears in the Photo Browser window. 
 
13. Click and drag this image into the spaces that read, “Put Photo Here!” 
 
14. Repeat this process by scanning more photos and inserting them in the blank cell photo frames until 

you have filled the whole album. 
 
15. Choose the Save As command from the Album menu.  Enter the file name and directory location in 

which you want to store the album.  Click OK to save the album. 
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CHAPTER 5.  HOW TO GET HELP 
 
The Astra 4000U scanners have been designed to be reliable, easy-to-install, and easy-to-use.  If you 
encounter any problems while installing or using your scanner, please follow the solutions outlined below. 
 
• Consult the online manual. 
• Read the troubleshooting section below. 
• Contact UMAX directly. 
 
Using Online Manuals 
 
All bundled software comes with online help, which essentially is an online manual.  Read the following 
information to find out how to access the manuals for each individual software application. 
 
Accessing the UMAX VistaScan Online Manual 
 
For PC Users: 
 
If the VistaScan application is already open, you can locate the manual by clicking on the user tips that pop 
up when your mouse scrolls over a tool.  If VistaScan is not open, follow the instructions below. 
 
1. Click Start. 
 
2. Click Programs. 
 
3. Click VistaScan. 
 
4. Click VistaScan User’s Guide.  Your Internet browser should launch the VistaScan User’s Guide. 
 
For Macintosh Users: 
 
If the VistaScan application is already open, you can locate the manual by clicking on the “?” icon located 
in the upper right corner.  If VistaScan is not open, follow the instructions below. 
 
1. Double-click the Hard Drive icon on the desktop. 
 
2. Double-click the UMAX VistaScan folder. 
 
3. Double-click the VistaScan Help.  Your Internet browser should launch the VistaScan User’s Guide. 
 
Accessing the Adobe PhotoShop Online Manual 
 
For PC Users: 
 
1. Place the PhotoShop LE CD in the CD-ROM drive.  (If the install screen automatically launches, skip 

to step 4.) 
 
2. Double-click My Computer. 
 
3. Right-click the CD-ROM drive and select AutoPlay. 
 
4. Click ReadMe & Guide.  From here, you can select the manual best suited to your needs. 
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For Macintosh Users: 
 
1. Place the Adobe PhotoShop LE CD in the CD-ROM drive. 
 
2. Double-click the PhotoShop LE CD icon on the desktop. 
 
3. Double-click English. 
 
4. Double-click Getting Started.pdf.  (If you receive an error, please install Adobe Acrobat Reader 3.01.  

See “Installing Acrobat Reader” below for instructions.) 
 
Accessing the Presto! PageManager Online Manual 
 
For PC Users: 
 
1. Click Start. 
 
2. Click Programs. 
 
3. Click Presto! PageManager Deluxe. 
 
4. Click PageManager User’s Manual. 
 
For Macintosh Users: 
 
1. Double-click the Hard Drive icon on the desktop. 
 
2. Double-click the Presto! PageManager 2.31.02 folder. 
 
Double-click User’s Guide.pdf.  (If you receive an error, please install Adobe Acrobat Reader 3.01.  See 
“Installing Acrobat Reader” below for instructions.) 
 
Accessing the Caere OmniPage Online Manual 
 
For PC Users: 
 
1. Click Start. 
 
2. Click Programs. 
 
3. Click Caere Application. 
 
4. Click English Documentation. 
 
For Macintosh Users: 
 
1. Double-click the Hard Drive icon on the desktop. 
 
2. Double-click the OmniPage LE folder. 
 
Double-click OmniPage Ltd.pdf.  (If you receive an error, please install Adobe Acrobat Reader 3.01.  See 
Installing Acrobat Reader below for instructions.) 
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Installing Acrobat Reader for Macintosh Users 
 
To read the OmniPage LE online manual you need to use Adobe Acrobat Reader.  If it is not already 
installed on your computer, follow the installation instructions below. 
 
1. Place the VistaScan CD in the CD-ROM drive. 
 
2. Double-click the UMAX VistaScan CD icon. 
 
3. Double-click the Acrobat Reader Install folder. 
 
4. Double-click the 3.0 folder. 
 
5. Double-click the Reader folder. 
 
6. Double-click the Install Acrobat 3.0 icon. 
 
Troubleshooting 
 
This scanner is designed to be reliable and easy to install.  If you have any problems with your scanner, 
please read the notes that follow to find out probable causes of the problem. 
 
General Problems and Solutions 
 
Problem: 
 
The scanner lamp fails to light, flickers, or dims. 
 
Solution: 
 
1. Check to ensure the power adapter is plugged in completely. 
 
2. The scanning lamp is failing or has failed and needs to be changed.  Please contact your dealer or 

UMAX Technical Support. 
 
Problem: 
 
The scanner test failed.  The scanner test utility is a PC-based utility.  Macintosh users will not encounter 
this problem. 
 
Solution: 
 
Make sure the interface cable is properly connected to the USB connector port on your computer.  
Find/refresh the scanner after reinserting the USB cable.  Try the other USB port on the computer. 
 
Windows 98/95 OSR2 Problems and Solutions 
 
Problem: 
 
Your computer does not recognize your USB scanner. 
 
USB support must be installed and enabled or the scanner will not work.  Different USB chipsets have 
different levels of USB compliance.  The initial USB chipset that was released was the INTEL82371SB.  It 
supports most low draw devices such as mice and joysticks, but high draw devices such as scanners might 
have trouble functioning on the “SB” chipset. 
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Later chipset versions include SIS, ALI, and both have fully functional chipsets as well as Intel’s 82371AB 
and 82371AB/EB. 
 
Solution: 
 
To determine your USB chipset type: 
 
1. Click the My Computer icon using the right mouse button.  A pop-up menu appears. 
 
2. Click on Properties command using the left mouse button.  This brings up the Device Manager. 
 
3. The last item listed in the Device Manager should be Universal Serial Bus Controllers. 
 
4. Click the + beside the Universal Serial Bus Controllers entry.  Two items display, (your chipset) PCI to 

USB Open Host Controller and Root Hub. 
 
If a yellow exclamation point appears, or if one or both of them are not present, please contact your 
computer manufacturer.  If the USB section is not shown in the Device Manager, we recommend you 
contact your computer manufacturer to enable USB. 
 
Problem: 
 
Your USB port worked with other USB devices, but does not work with the scanner. 
 
Solution: 
 
It is important that you connect the scanner’s power and USB cables in the following order: 
 
1. Plug the power adapter cord into the scanner and into the outlet.  The scanner’s power will then be ON. 
 
2. Connect the USB cable to the USB port on the back of the computer. 
 
NOTE:  If you unplug the scanner’s power to turn it off, you must also disconnect the USB cable from the 
computer.  To resume use of the scanner, reconnect the power cord, and then the USB cable. 
 
To use your Astra 4000U scanner, it is important that your computer is set up to correctly support a USB 
device.  You must have the following: 
 
• Windows 95 OSR2, revision B or later 
 

To check your system: 
 
1. Right click on your My Computer icon. 

 
2. Select Properties. 

 
3. Select the General tab. 

 
4. You should see a Windows version number of 4.00.950B or 4.00.950C. 

 
5. If you have a different version, contact your reseller or Microsoft for an upgrade. 

 
• Windows USB Supplement installed (Windows 95 only) 
 

To check your system: 
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1. Click Start on the Windows taskbar. 
 

2. Click Settings. 
 

3. Click Control Panel. 
 

4. Double-click the Add/Remove Software icon. 
 

5. You should see a listing for “USB Supplement/OSR2”. 
 

6. If you do not see the supplement listed, you must install it from the Windows95 CD. 
 
Problem: 
 
IRQ steering is disabled.  For USB to function properly, IRQ Steering must be enabled. 
 
Solution: 
 
The IRQ Steering setting is located in the Device Manager.  Follow the steps below to find out if the IRQ 
steering is enabled: 
 
1. Click the My Computer icon using the right mouse button.  A pop-up menu appears. 
 
2. Click on Properties using the left mouse button.  This brings up the Device Manager. 
 
3. In the Device Manager click the + symbol beside the System Devices item. 
 
4. Double-click the PCI Bus to display the PCI Bus Properties. 
 
5. Click on the tab labeled IRQ Steering. 
 
6. The bottom half of this tab displays the IRQ Routing Status.  Look for the following items: 
 

• IRQ Routing enabled 
• IRQ read from (where it is read from) 
• IRQ Mini-port loaded successfully 
• IRQ Mini-port data processed successfully 

 
If you see these items as listed above, IRQ Steering is enabled.  If you do not see the information, contact 
your computer manufacturer.  USB will not function properly without IRQ Steering. 
 
Problem: 
 
Scanner is not present in the Device Manager.  The scanner must be present in the Device Manager.  If 
there is no listing for it, the scanner will not work. 
 
Solution: 
 
Follow the steps below to determine if the scanner is present in the Device Manager. 
 
1. Click the My Computer icon using the right mouse button.  A pop-up menu appears. 
 
2. Click on Properties using the left mouse button.  This brings up the Device Manager. 
 
3. The scanner should be listed under the heading of Imaging Device. 
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4. If it is not present, insert the UMAX VistaScan CD-ROM into the CD-ROM drive and reinstall 
VistaScan. 

 
5. Unplug the scanner cable from the back of the computer, and then plug it back into the USB port. 
 
6. Verify there is power to the scanner. 
 
7. If the scanner does not show up, and there is no change in the Device Manager, try another USB port.  

If the scanner still does not appear, contact your computer manufacturer. 
 
Problem: 
 
Your system resources are low.  Your system resources are the amount of free resources your system can 
call on at a given time.  This should be at 90% or above to run a scanner.  Anything under 60% will cause 
system freezes or link fails when you attempt to access the scanner. 
 
Solution: 
 
Follow the steps below to determine if your system resources are too low to operate the scanner. 
 
1. Click the My Computer icon using the right mouse button.  A pop-up menu appears. 
 
2. Click on Properties using the left mouse button. 
 
3. Click the Performance tab (the fourth tab under System Properties). 
 
4. Look in the System Resources area (the second section).  This number should be above 90%. 
 
5. If not, press and hold down the CTRL+ALT keys and tap the Delete key once.  This brings up the 

Close Programs window. 
 
6. You need to end all tasks running except the EXPLORER and SYSTRAY items.  To end a task, 

highlight an item in the Close Programs window and click the End Task Button.  Repeat this step for 
each task you want to end.  The programs will return upon restart.  Repeating this process may be 
necessary. 

 
Macintosh Problems and Solutions 
 
Problem: 
 
When I daisy chain the scanner with other USB capable devices, I get a scanner error. 
 
Solution: 
 
Many Macintosh computers have at least two USB ports.  We recommend that you connect your scanner 
directly to one of these ports.  Daisy-chaining the scanner, or running the scanner through a hub, can cause 
the signal to be lost before it is communicated to your computer. 
 
To make the troubleshooting process easier, disconnect your scanner from other USB capable devices or 
hubs when troubleshooting. 
 
Problem: 
 
I cannot get the scanner to install properly, or it does not run once it is installed. 
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Solution: 
 
If you are having problems installing or using the Astra 4000U scanner, ensure that Macintosh OS 8.0 or 
higher is installed on your computer. 
 
Problem: 
 
The system takes too long to scan. 
 
Solution: 
 
Disable virtual memory, reboot your computer with the extensions disabled (hold down the SHIFT key 
during re-boot) and try again.  Booting with the shift key still loads the UMAX scanner extension required 
for scanning. 
 
Problem: 
 
Your system goes to the Finder when you try to acquire the scanner. 
 
Solution: 
 
Plug the scanner into its own power outlet.  If still does the same thing, please call UMAX Technical 
Support. 
 
Problem: 
 
The following error message appeared:  “Error: Not enough Power to Function” 
 
Solution: 
 
The Macintosh OS generates this message if: 
 
• A device draws too much power from the USB bus 
• One or more devices plugged into a hub require more power than is available 
• You attached a self-powered device (such as a printer or floppy drive) to your computer without 

plugging it into an electrical outlet. 
 
Remove all other devices from the USB chain, so the scanner is the only device on the USB chain.  Make 
sure that the scanner power adapter is plugged directly into the wall, not into a power strip. 
 
Problem: 
 
The following error message appeared:  “Error: No Driver Found” 
 
Solution: 
 
The Macintosh OS generates this message if it could not find a driver in the System Folder for the USB 
device you just connected.  You may have forgotten to install the software that came with the device, or 
you may have put the device driver (i.e., the software that allows Macintosh to recognize and communicate 
with the USB device) in the wrong place in your System Folder. 
 
Re-install the software driver from the VistaScan CD-ROM.  Make sure the scanner extension is loaded 
and on. 
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Problem: 
 
The following error message appeared:  “Scanner not found” or “Unable to control scanner” 
 
Solution: 
 
Follow this procedure: 
 
1. Confirm the scanner is plugged into the computer’s USB port. 
 
2. Go to the Apple System Profiler, listed under the Apple menu. 
 
3. Go to the Devices & Volumes tab.  Verify the scanner is listed under the USB tree as: 
 

Class: 0 
Product ID: 16 
Vendor ID: 5638 

 
4. If not, disconnect the USB cable from the computer. 
 
5. Go to Command, Update All Information (Command + U). 
 
6. Reconnect the scanner, and Update All Information again.  Is the scanner listed?  If yes, you can begin 

scanning.  If no, please call UMAX Technical Support. 
 
Try the following solutions, if you are still experiencing scanning problems: 
 
1. Plug the scanner power adapter directly into the wall outlet and not in a surge protector. 
 
2. If using a USB hub, plug the scanner directly into the Macintosh USB port. 
 
3. If you are using iMac, do not run the scanner off the keyboard. 
 
Download all updates for your Macintosh for USB from the Apple’s Web site http://www.apple.com 
 
Contacting Technical Support 
 
UMAX Astra scanners are designed to be reliable, easy-to-install, and easy-to-use.  If you encounter any 
problems while installing your scanner: 
 

• Check out the UMAX Web site at www.umax.com/support 
 

• E-mail UMAX with your technical support question at:  support@umaxcare.com 
 

• Contact your dealer or call the UMAX support line between 9 A.M. – 5 P.M. (CST), Monday-
Friday, at 214-739-1915. 

 
Before calling, please have the following information ready: 
 

• The scanner model and serial number. 
 
• The version number of the scanner driver (located on the front of the CD) 

 
• The computer model you are using 
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• The printer and model that you are using (if applicable) 
 

• The application software packages that you are using 
 

• Error codes or messages seen 
 

• A description of what you were doing at the time of the malfunction so that the problem can be 
recreated 

 
• Other observations that may aid the technician in identifying the problem and solution 

 
When you call, please be in front of your computer.  You will need to have your scanner and the computer 
turned on.  Try to have as much information about your problem as possible.  This information allows the 
technician to more effective troubleshoot your problem. 
 
 
Product Registration 
 
To register your UMAX scanner please go to the UMAX Web site at:  www.umax.com/support/registration 
and follow the online instructions. 
 
Maintenance 
 
With the exception of periodic cleaning, the scanner is virtually maintenance-free.  Please read the 
following section to learn how to properly maintain the scanner. 
 
Cleaning 
 
Regularly cleaning the object glass will ensure that dirt or smudges will not reduce the quality of your 
scanned images.  Before you clean the glass, make sure the scanner is turned off and the power cord is 
unplugged.  Clean the object glass and document cover with a soft damp cloth and a mild detergent or 
alcohol. 
 
Warning:  Do not spray the cleaning fluid directly on the object glass.  Spraying the liquid directly on the 
glass may cause the liquid to penetrate the seams around the glass and contaminate the mirrors and lenses 
inside the scanner.  Please be sure you spray the liquid on the cleaning cloth and then wipe the glass clean. 
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APPENDIX A.  TECHINICAL SPECIFICATIONS 
 
The following table defines the technical specifications for the Astra 4000U Scanners. 
 
Scanner Specifications 

Scanner Type 1-pass color flatbed 

Scanning Element Color CCD 

Optical Resolution 
Maximum Resolution 

1200 dpi x 2400 dpi                     
9600 dpi x 9600 dpi 

Color Density 36-bit color, up to 42-bit output 

Light Source Cold Cathode Lamp 
Optics Enclosed Optical System 

Interface Astra 4000U - USB 

Operating System 

Astra 4000U - Windows 95, 98, 
Mac OS 8.0+ (for iMac and USB 
compatible Macintosh computers) 

Scanning Modes 

B/W, halftone, 8-bit grayscale, 12-
bit grayscale, 24-bit color, 36-bit 
color 

Maximum Document Size 8.5" x 14" 

Scanner Dimensions 21.4" x 13" x 4.1" 
Approx. Scanner Weight 9.9 lbs. 
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